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How to Create Chronologies, Graphs, Timelines, Calendars, and 

other Visual Aids to Enhance Your LNC & Expert Witness Reports 

Topics: 

1. Why Attorneys Use Visual Aids or “Demonstrative Evidence” in Litigation. 

2. The Different Types of Graphics Used 

3. Why Graphics are Essential for Attorneys, LNCs, and Nurse Experts. 

4. What is “Demonstrative Evidence”? 

▪ Benefits of Demonstrative Evidence 

▪ Admissibility of Demonstrative Exhibits 

5. How to Create a Table or an Excel Spreadsheet for a Medical Chronology Using 

Microsoft Word 

6. Formatting and Content Pointers 

7. How to Create a Calendar using Microsoft Word 

8. How to Create Line Graphs (Timelines) in Microsoft Excel 

9. How to Create a Timeline in PowerPoint 

10. Real Case Examples of (starts on p. 20):  

o Different Formats for Chronologies 

o Tables for medication administration, etc. 

o Graphs of vital signs, O2 saturation, PTT, etc.  

o Calendars and timelines of medical events for PI and med mal cases 

o and much more! 

A LNC needs to be able to provide the attorney with medical literature, definitions of medical 

terminology, and anatomy drawings/graphics to facilitate the attorney’s understanding (and later 

the jury’s) of the medical issues in a case. LNCs can play a pivotal role in assessing many 

elements of a case by providing focused chronologies. For example, preparing a chronology with 

medical record excerpts pertaining to damages which identifies those injuries caused by the 

defendant(s)’ negligent acts. Sometimes this is called a “pain and suffering” chronology. 
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In addition, if you are acting as a nurse expert witness it is essential that you use timelines and 

graphs to enhance your reports and the persuasiveness of your testimony. Visual representations 

of complex medical data can make your arguments more compelling and memorable, increasing 

your credibility as an expert witness or consultant. 

Lastly, a LNC who is able to include graphs, timelines and calendars will stand out in the 

competitive field of legal nursing. This will also increase the expert or consultant’s role 

throughout the litigation, making them a valuable part of the trial team.  

1. Why Attorneys Use Visual Aids or “Demonstrative Evidence” in Litigation.  

Numerous studies have indicated that jurors respond well to visual aids, and that graphic 

evidence drastically increases their rate of information retention from 10% to 87%. Because the 

average juror is more likely to remember what they see rather than what they hear, it is helpful to 

incorporate visual depictions of evidence whenever possible. For that reason, demonstrative 

evidence is also used in settlement discussions, mediations, and other proceedings. 

Further, demonstrative evidence greatly enhances an expert’s ability to communicate complex 

concepts and increases the expert’s credibility and persuasiveness by helping the jury better 

understand the case issues.  

2. The Different Types of Graphics Used. 

Many different types of media are used to develop demonstrative evidence. Medical records and 

other documents can be enlarged to use as things are explained by experts and others. 

Photographs of the injured party or the scene of the accident are also commonly used. Sometimes 

these are put together on “presentation boards” or in PowerPoint slides. 

• 3D models to view from an item from multiple angles i.e. a heart model 

• Computer Generated Animations that simulate the key issues being explained 

• Graphics for example: tables, graphs, timelines, calendars, and more 

• Interactive exhibits that magnify particular case points and themes 

• Videos such as a Day in the Life recordings. 

http://csattorneys.com/wp-content/uploads/2011/03/Demonstrative-Evidence.pdf
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Developing the skills to create chronologies, timelines and graphs for key medical information 

empowers legal nurse consultants (LNCs) and nurse expert witnesses to communicate complex 

medical concepts with clarity and persuasiveness. By using visual aids to organize, highlight, and 

explain key medical facts, you will greatly enhance your effectiveness as an expert witness and 

will increase your ability to participate in strategy discussions with the attorneys trying the case. 

You can give suggestions to the firm regarding the content and media to be used and may be 

asked to work with the firm’s graphics designer or medical illustrator. 

3. Why Graphics are Essential for Attorneys, LNCs, and Nurse Experts. 

Graphs, tables, timelines, calendars and other visual aids are essential because they: 

✓ Provide Clarity and Organization of Medical Information: Complex medical cases 

often involve numerous events, treatments, and outcomes over time. By creating 

timelines and graphs, you can organize this information in a clear and concise manner, 

making it easier for legal professionals, judges, and jurors to understand the sequence of 

events and how they relate to each other. 

✓ Visual Aids Help Juries Understand Complex Medical Events: Visual aids such as 

timelines and graphs have a powerful impact on comprehension and retention. They 

provide a visual representation of the medical information, allowing others to grasp key 

details quickly and intuitively. This visual clarity can be especially beneficial in cases 

where technical medical terms and concepts may be challenging for non-medical 

professionals to grasp. 

✓ Focus on Key Medical Events as They Relate to the Legal Issues: Timelines and 

graphs allow you to highlight crucial events, such as the onset of symptoms, diagnostic 

tests, treatment interventions, and patient outcomes. By clearly delineating these 

milestones, you can draw attention to key points in the medical narrative that are relevant 

to the legal issues at hand. 
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✓ Help Prove Causation: Establishing causation is a critical element in all injury cases. 

Timelines and graphs enable you to demonstrate the chronological sequence of events 

and illustrate the causal relationship between medical actions and outcomes. This can be 

instrumental in proving or refuting allegations of medical negligence, malpractice, or 

causation of injuries. 

✓ Enhance Your Persuasiveness and Credibility: Presenting well-constructed timelines 

and graphs can significantly enhance the persuasiveness of your testimony or reports. 

Visual representations of complex medical data can make your arguments more 

compelling and memorable, increasing your credibility as an expert witness or consultant. 

✓ Demonstrate Your Expertise: Demonstrating proficiency in creating timelines and 

graphs reflects your professionalism and competence as a legal nurse consultant or nurse 

expert witness. It showcases your ability to distill complex medical information into 

accessible formats and effectively communicate key insights to legal audiences. 

✓ Increase Your Collaboration with Attorneys: Collaborating with attorneys to create 

timelines and graphs fosters a more effective partnership between legal and medical 

experts. By contributing your expertise in medical data visualization, you can play a 

pivotal role in shaping the legal strategy for trial and presenting a compelling case to 

achieve favorable outcomes for clients. This increases your value to attorneys. 

In conclusion, mastering the art of creating timelines and graphs regarding medical information 

empowers legal nurse consultants and nurse expert witnesses to communicate complex medical 

concepts with clarity, persuasiveness, and expertise. By leveraging visual aids to organize, 

highlight, and explain key medical facts, you can enhance your effectiveness as an expert and as 

a valuable asset to the law firm. 

4. What is “Demonstrative Evidence”? 

Demonstrative evidence generally refers to evidence that offers a physical illustration of a fact 

presented, rather than a verbal description. While real evidence is substantively used to prove a 

https://monseesmayer.com/articles/evidentiary-foundations-for-demonstrative-evidence/
https://monseesmayer.com/articles/evidentiary-foundations-for-demonstrative-evidence/
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fact at issue in the case, demonstrative evidence is used to clarify, explain, and offer a visual 

explanation of the presentation. 

Demonstrative evidence can come in many forms—photographs, video animations, graphs, 

diagrams, charts, slideshows, drawings, computer graphics, and simulations—the list goes on 

and on. The advent of three-dimensional computer-generated technologies, such as virtual reality 

and augmented reality programs (the latter of which overlays virtual, 3-D images over the real-

life environment) has taken demonstrative evidence to a whole new level. 

➢ Benefits of Demonstrative Evidence 

By definition, the purpose of expert testimony is to help the trier of fact understand the evidence 

or determine a fact in issue. (See Federal Rules of Evidence Rule 702). As such, demonstrative 

evidence should work as an extension of the expert by offering a visual representation of the 

expert’s testimony. Ideally, the evidence should help the jury understand relevant facts that 

would otherwise be difficult to comprehend without the aid. Demonstrative evidence may also be 

used to emphasize important aspects of the testimony. The ways in which a demonstrative 

exhibit may be helpful at trial are as varied as the types of evidence themselves. 

In cases involving personal injuries sustained as a result of an accident, demonstrative evidence 

in the form of a reconstruction can be particularly helpful. While an accident reconstruction 

specialist testifying to the cause of a vehicle collision may base their testimony on a number of 

scientific methods (such as energy analysis and time distance analysis), such technical principles 

may be difficult to follow when described in verbal testimony. A visual reconstruction, which 

can be as simple as a scaled drawing of the scene or as complex as a virtual reality reconstruction 

of the size and speed of the vehicles, can help bring the testimony to life. 

Similarly, most medical experts will benefit from using demonstrative evidence because their 

testimony is complex in nature and difficult for a jury to conceptualize. When discussing a 

party’s injuries, for example, the expert can use photographs or graphic models to pinpoint the 

affected areas. Life-size replicas of the anatomy are also sometimes used to explain the causes of 

injury. Technology in this field is rapidly advancing and should be utilized whenever feasible.  

http://csattorneys.com/wp-content/uploads/2011/03/Demonstrative-Evidence.pdf
https://www.vrs.org.uk/virtual-reality/what-is-virtual-reality.html
https://www.law.cornell.edu/rules/fre/rule_702
http://www.facts-1.com/whatisaccidentreconstruction.htm
http://www.facts-1.com/whatisaccidentreconstruction.htm
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The virtual examination of a body offers a number of benefits during expert testimony. It is a 

realistic, detailed demonstrative aid that avoids the logistical issues of life-size anatomical 

models that would need to be passed to each juror to obtain a full view. 

That being said, not all demonstrative evidence is failsafe. Sometimes, in an effort to create the 

most informative aid, the actual information gets lost in the shuffle (i.e., graphs packed with 

small text that cannot be clearly read). Also, in the case of computer-generated graphics or other 

hyper-realistic imaging, some jurors may experience cognitive overload if the exhibit is too 

flashy or “busy.” As a logistical matter, some aids simply won’t work in certain courtrooms. For 

example, an elaborate computer simulation will be stopped in its tracks if the courtroom is not 

equipped with the correct wiring to connect the computer to the projection screen.  

➢ Admissibility of Demonstrative Exhibits 

Like any other exhibit offered at trial, demonstrative evidence is subject to the applicable 

evidentiary rules of the jurisdiction. A proper foundation needs to be established in order to 

successfully admit the exhibit into evidence at trial. Laying the foundation of a demonstrative 

exhibit through an expert witness consists of questions that establish its authenticity such as: 

Does this exhibit help explain your testimony to the jury?  

Demonstrative aids are also subject to the applicable relevancy rules. Under Rule 401 of the 

Federal Rules of Evidence (and certain state laws that have adopted such a rule), evidence is 

deemed relevant if it has any tendency to make a fact more or less probable than it would be 

without such evidence and the fact is of consequence in determining the action. Under Rule 403, 

a judge may exclude otherwise relevant evidence if its probative value is substantially 

outweighed by the danger of “unfair prejudice, confusing the issues, misleading the jury, undue 

delay, wasting time, or needlessly cumulative evidence.” 

Rule 1006 permits the use of “a summary, chart, or calculation to prove the content of 

voluminous writings, recordings, or photographs that cannot be conveniently examined in court.” 

In other words, demonstrative exhibits can be used to summarize otherwise voluminous evidence 

https://phys.org/news/2017-06-augmented-reality-medical-professionals.html
https://www.legalexaminer.com/legal/foundation-for-demonstrative-evidence/
https://www.expertinstitute.com/services/expert-witness-search/
https://www.law.cornell.edu/rules/fre/rule_1006
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(i.e., a chart highlighting key relevant portions of writing), but the mode and order in which it is 

presented is ultimately at the discretion of the judge. 

Overall, when effectively utilized, demonstrative evidence and visual aids can enhance an 

expert’s testimony in ways that oral testimony cannot. The impact of visual aids is significant. 

5. How to Create a Table or an Excel Spreadsheet for a Medical Chronology Using 

Microsoft Word 

A good medical chronology provides a detailed timeline of the pertinent medical events in the 

case. But a really good chronology is tailored to the facts of the case that are relevant to the legal 

issues in the lawsuit. What facts should you highlight? It depends on the purpose of the 

chronology; is it to:  

❖ Create a chronological description of medical symptoms, treatment, surgical 

procedures or other events? 
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❖ Focus on the exact timing of events (i.e. timing of C-section)? 

  

❖ Correlate several factors such as lab values, vital signs, medication administration? 

 

❖ Compare the description of events by different HCPs (i.e. if inconsistent)  

❖ Show deviations from the standards of care (quote and cite authoritative source)? 
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❖ Contrast deposition testimony with the events recorded in the medical record 

(i.e. if there are inconsistencies)?   

 

The easiest way to create a report for your attorney client is using the “Tables” function in 

Microsoft® Word. Tables take all of the guess work out of formatting and are easy to use. To 

create a table in Word you simply click on the following 3 items from the ribbon: Insert > then 

Table > then Insert Table.  

Step by Step Instructions. Below are detailed step-by-step instructions on how to create a table 

using Microsoft Word: 

Step 1: Open Microsoft Word 

Open Microsoft Word on your computer. If you don't have it installed, you can use alternative 

word processing software like Google Docs. 
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Step 2: Insert Table or Excel Spreadsheet 

• Click on the "Insert" tab on the top menu bar. 

• Click on the "Table" or “Excel Spreadsheet” option. 

• You can choose the number of rows and columns you need. A medical chronology table 

might have columns for such things as Date, Medical Events (including symptoms, 

diagnosis, treatment, etc.), page or bates numbers, and LNC Comments. You can adjust 

the number and size of rows and columns based on your specific needs. 

Step 3: Enter Data 

• Once you've inserted the table, start entering the data into each cell. Here's a breakdown 

of the typical columns and what you might include in each: 

o Date: The date of each medical event or encounter. 

o Event Description: A brief description of what happened during each event, such 

as a doctor's visit, medical procedure, or symptom onset. 

o Symptoms: Any symptoms experienced by the patient leading up to or during 

each event. 

o Diagnosis: The medical diagnosis given by the healthcare provider, if applicable. 

o Treatment: Any treatments, medications, or interventions provided or prescribed. 

o LNC Comments: Additional relevant information or details about each event. 

Step 4: Format the Table 

• Highlight the table by clicking and dragging over it. 

• Use the formatting options in the toolbar to adjust the appearance of the table. You can 

change the font style, size, and color, as well as adjust the cell borders and alignment to 

make the table more visually appealing and easier to read. 

Step 5: Save Your Document 

• Once you've finished creating and formatting the table save your document so you can 

access it later or make edits as needed. You can also use it as a template for future tables! 
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Tips: 

• Leave a space before and after each entry in a cell of the chronology  

• Consider using different colors or shading for alternating rows to improve readability. 

• Use bold or italic formatting for headers or important information to make them stand 

out. 

• If your chronology is extensive consider breaking it up into sections (i.e. by facility etc. 

and use a different color band to each facility), or using multiple tables for different time 

periods or types of events. 

By following these steps, you should be able to create a well-organized and formatted medical 

chronology table using Microsoft Word or a similar word processing program. 

For more step by step instructions see, 8 Formatting Tips for Perfect Tables in Microsoft 

Word - https://www.makeuseof.com/tag/8-formatting-tips-perfect-tables-microsoft-word/. 

6. Content Pointers  

▪ Use meaningful and descriptive titles and headings i.e., “Chronology of John Smith’s 

Hospitalization at Community Hospital, 02/11/21-02/17/21.” 

▪ List events and other data in chronological order. Put data in similar order in each day’s 

entry. 

▪ Present all similar data in columns. For example, all blood pressure readings, all 

temperature readings, all heart rate readings – so the reader can see trends. Title each 

column and row.  

▪ The title and headings should be repeated on each page. 

▪ Clearly separate facts from your comments. The “Medical Events” column should only 

contain facts from the medical records and other documents. Your comments about what 

should be put in the “Comments” column. Be careful not to mix the two up. Even when 

you’re summarizing or paraphrasing the medical records, you’re still describing the event 

– so put this in the Events column.  

https://www.makeuseof.com/tag/8-formatting-tips-perfect-tables-microsoft-word/
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▪ Your opinions related to any deviations from the standards of care, inconsistent 

information or statements, missing records, relevant deposition testimony, etc. go in the 

“Comments” column. 

▪ Column widths. If you have extensive comments, make that column wider. If your Event 

descriptions are longer, give that column more space. Make the Date/Time column as 

narrow as possible to save space. 

▪ Use landscape layout if that will help you present the data more compactly or more 

effectively. Often landscape works best when you have numerous columns. 

▪ Keep the grid lines light and thin to avoid distracting from your data. However, use a 

bold line and /or different color to separate information from different facilities. 

 

7. How to Create a Calendar using Microsoft Word 

 

You can create a calendar in Microsoft Word using “Tables” or by inserting a pre-designed 

calendar template. Here's how to do it using Tables: 

1. Open a New Document: Launch Microsoft Word and open a new blank document. 
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2. Insert a Table: Go to the "Insert" tab in the menu bar and select "Table." Choose the 

number of rows and columns you need for your calendar. A typical calendar might have 7 

columns (for the days of the week) and 5 to 6 rows (for the weeks in a month). 

3. Format the Table: Adjust the size of the cells to fit the content. You can do this by 

clicking and dragging the borders of the cells. You may also want to adjust the width of 

the columns to make them equal. 

4. Add Dates: Enter the dates for the month into the appropriate cells, starting with the first 

day of the month. Typically, the first row will contain the days of the week (e.g., Sunday, 

Monday, Tuesday, etc.), and subsequent rows will contain the dates. 

5. Customize: You can customize your calendar further by adding colors, borders, and 

additional formatting to make it visually appealing. 

6. Add Events: You can add events or appointments to specific dates by typing them 

directly into the corresponding cells. 

Alternatively, you can search for calendar templates within Microsoft Word and choose one that 

fits your needs. To do this: 

1. Open a New Document: Launch Microsoft Word and open a new blank document. 

2. Search for Templates: In the search bar at the top of the screen, type "calendar" and 

press Enter. 

3. Select a Template: Browse through the available calendar templates and choose one that 

suits your preferences. 

4. Customize: After selecting a template, you can customize it further by adding your own 

text, changing colors, and adjusting the layout. 

5. Save: Once you've finished customizing your calendar, save the document to your 

desired location. 
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8. Creating Line Graphs (Timelines) in Microsoft Excel 

If an attorney asks you to prepare a timeline for a case, be sure to clarify what type of timeline 

they want. Some attorneys may use the words timeline and chronology interchangeably. A 

timeline is a type of report that identifies only key events related to the allegations over a defined 

period of time. The hardest thing in creating a timeline is narrowing the focus. Timelines are 

often used as trial exhibits. 

Creating a graph or timeline of data such as vital signs can be done easily using software tools 

like Microsoft Excel, Google Sheets, or even specialized data visualization libraries in 

programming languages like Python (using libraries like Matplotlib or Seaborn).  

Here's a general step-by-step guide for creating a timeline using Microsoft Excel: 

1. Gather your data: Collect the data you want to graph. For example, if you want to display 

significant vital signs, this could include metrics like heart rate, blood pressure, 

temperature, respiratory rate, etc. Make sure you have each measurement paired with a 

corresponding time or date stamp. 

2. Open Excel. You can use an existing project or create a new spreadsheet.  

o Microsoft Excel is available on Windows and Mac. You can also use the online web 

version at https://www.office.com/. You can use Excel to make tables and more. 

3. Enter your data: Input or type your data into Excel (i.e. vital signs). You can have one 

column for the timestamp and another for the corresponding vital signs measurement. 

4. Select the data: Click and drag to select (highlight) the cells containing your data. Make 

sure you include both the timestamp and the vital sign measurement. 

5. Highlight your data. Click and drag over the cells containing the data you want to use in 

your line graph. Be sure to select column headers if you have them.  

o To select everything, click the top-left cell of the data. Press CTRL + A (Windows) 

or Command + A (Mac). 

https://www.wikihow.com/Make-a-Spreadsheet-in-Excel
https://www.office.com/
https://www.wikihow.com/Use-Excel
https://www.wikihow.com/Make-Tables-Using-Microsoft-Excel
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6. Click the Insert tab at the top toolbar to insert a chart: Go to the "Insert" tab in Excel's 

toolbar. Click on "Chart". Choose the type of chart you want to create. For vital signs, a 

line chart or scatter plot is often suitable. 

7. Click the graph icon. This looks like two intersecting line graphs. You can find this in the 

Charts section. 

8. Hover over a line graph style. Hover the mouse cursor over a line graph template in the 

drop-down menu to see what it will look like with your data. 

9. Click a graph style to select it. Once you decide on a line graph template, clicking it will 

create your graph in the middle of the Excel window 

Customizing the Graph 

❖ Change your graph's style. Once you create your graph, the Chart Design toolbar will 

open. You can select one of the styles in the toolbar to quickly select a new look for your 

line chart.  

❖ If this toolbar doesn't open, click your line graph and then click the Design tab in the 

green ribbon. 

❖ Move your line graph. Click and drag the white space near the top of the line graph to 

move it.  

❖ You can also move specific sections of the line graph (e.g., the title) by clicking and 

dragging them around within the line graph's window. 

❖ Resize the graph. Click and drag one of the circles on one of the edges or corners of the 

graph window in or out to shrink or enlarge your graph.  

❖ Change the graph's title. Double-click the title of the graph, then select the "Chart Title" 

text and type in your graph's name. Clicking anywhere off of the graph's name box will 

save the text.  

❖ If you want to label your graph's axis, click the graph.  

o Click + at the right side of the graph. A pop-up menu will open. 

o Check the box for Axis Titles. 

https://www.wikihow.com/Label-Axes-in-Excel
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o Double-click the Axis Title box and delete the default text. 

o Enter a new title. 

You can find a video on how to create Excel charts and graphs at: 

https://www.youtube.com/watch?v=eHtZrIb0oWY  

Formatting Tips 

1. Customize your chart: Once the chart is inserted, you can customize it further. You can 

add titles, axis labels, gridlines, and legend to make the graph easier to understand. You 

can also change the colors and styles of the lines or points representing your data. 

2. Format the axis: Make sure the axis are appropriately scaled to display your data clearly. 

You might need to adjust the minimum and maximum values, as well as the intervals on 

the axis. 

8. Add additional data: If you have multiple sets of vital signs to compare, you can add 

them to the same chart by selecting the additional data and inserting it into the chart. 

9. Save and export: Once you're satisfied with your graph, save your Excel file. You can 

also export the graph as an image file (e.g., PNG) if you need to share it outside of Excel. 

Remember, this is just one way to create a graph of vital signs. Depending on your preferences 

and requirements, there are many other tools and methods you can use. If you're comfortable 

with programming, using libraries like Matplotlib in Python can offer more flexibility and 

customization options. 

Pointers 

For example, a timeline which was created to show how a fever was treated ineffectively, a 

timeline was created using Microsoft Word. It focuses on the 21-hour period over which the 

fever was treated. There was a great deal of documentation during this period but only the 

temperature, patient mentation/level of consciousness and interventions related to the fever are 

https://www.youtube.com/watch?v=eHtZrIb0oWY
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included in the timeline attached. This timeline was custom-made using a 21-column table with 

text boxes and lines drawn to specific times on the table.  

 

This case involved a physician who failed to timely diagnose and treat several conditions. The 

defense wanted to show that it was the plaintiff who failed to follow through on physician 

referrals and recommendations. This attached timeline shows the Plaintiff’s failure to comply 

with appointments and referrals. 

 

Now that you know how to create timelines, you can use them to help explain complex events in 

an easy-to-understand way and impress your attorney clients! 

 

9.  How to Create a Timeline in PowerPoint 

To create a chronology or timeline in PowerPoint with a horizontal format with images or 

symbols next to key events, follow these steps: 

1. Insert a Horizontal Timeline: 

o Open PowerPoint and create a new slide. 

o Go to the "Insert" tab in the PowerPoint ribbon. 

o Click on "SmartArt" in the Illustrations group. 

o Choose a timeline layout that suits your preference, such as "Basic Timeline" or 

"Circle Accent Timeline." 

2. Add Timeline Events: 

o Click on the shapes in the timeline to add text boxes for each event. 

o Enter the dates, times, and descriptions of the events. 

3. Insert Images or Symbols: 

o Find images or symbols that represent each event in your timeline. 

o Insert these images or symbols next to the corresponding text boxes. 

https://www.lnctips.com/sampletimeline1.pdf
https://www.lnctips.com/sampletimeline2.pdf
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o To insert an image, go to the "Insert" tab, click on "Pictures," and choose the 

image file from your computer. 

o To insert symbols, you can either use PowerPoint's built-in symbols or insert 

icons from external sources like the Noun Project. 

4. Customize Formatting: 

o Adjust the formatting of the timeline, text boxes, and images to make them 

visually appealing. 

o You can change the colors, fonts, and sizes to match your presentation's theme. 

5. Add Visual Enhancements: 

o Consider adding additional visual elements to enhance the timeline, such as 

shapes, lines, or background colors. 

o Use these elements to create a visually appealing layout that highlights key 

events. 

6. Review and Finalize: 

o Review your timeline to ensure that the dates, times, descriptions, and images are 

accurate and effectively communicate the chronology of events. 

o Make any necessary adjustments or revisions. 

7. Present or Save: 

o Once you're satisfied with your timeline, you can present it in your PowerPoint 

slideshow. You can also save the slides as an image or PDF file to share. 

By following these steps, you can create an engaging and visually appealing chronology or 

timeline in PowerPoint with images or symbols next to key events. 
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How to Export a Graph Created in Excel 

Exporting a graph created in Excel is a straightforward process: 

1. Select the Graph: Click on the graph to select it. Ensure that the entire graph is 

highlighted. 

2. Access the Export Option: Look for the "File" tab in the Excel menu bar and click on it. 

Then, choose "Save As" or "Export" from the dropdown menu. 

3. Choose File Format: In the dialog box that appears, select the desired file format for 

export. Common options include PDF, PNG, JPEG, or even PowerPoint. 

4. Specify Location and Name: Navigate to the folder where you want to save the exported 

graph. Give the file a relevant name. 

5. Save the File: Click the "Save" or "Export" button to save the graph in the chosen format 

and location. 

Following these steps will allow you to export your Excel graph for use in presentations, reports, 

or other documents. 

Adobe Illustrator 

Adobe Illustrator is a sophisticated program that enables the user to create images in layers. It 

facilitates the integration of icons or symbols to visually depict a timeline of events. By using its 

intuitive interface and robust tools, users can effortlessly assemble and arrange graphical 

elements to create compelling timelines that effectively communicate the progression of events. 

While Illustrator offers a wealth of creative possibilities, mastering its full potential may require 

an initial investment of time and effort due to its advanced functionalities and rich feature set. 

See www.adobe.com 
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• Nurse Marble failed to perform and document the patient’s status at the time of 

discharge from the PACU which includes motor and sensory function. According to 

the American Society of PeriAnesthesia Nurses (ASPAN) 2019-2020, Discharge 

Assessment and Management: Phase 1 notes the nurse collects and documents data to 

evaluate the patient’s status for discharge including but not limited to sensory and 

motor function.  

• Nurse Marble failed to request anesthesia for a bedside consult for pain control and 

failed to ask anesthesia to re-evaluate the patient prior to discharge from the PACU. 

Nurse Marble failed to advocate for the patient. She had excruciating pain evidenced 

by documented “Facial expression: grimacing, Body movements: restlessness. 

Muscle tension: tense rigid. Vocalization: crying out, sobbing” which required the 

knowledge of a higher level of assessment in order to determine the underlying cause 

of her pain.  

 

1. Nurse Marble failed to possess sufficient knowledge, training and experience in 

understanding the pharmacokinetics and pharmacodynamics of opioids. It is below the 

standard of care to administer medications including Fentanyl 150mcg, Dilaudid 1mg and 

Versed 1.5mg over a 28-minute time frame. This is considered stacking of opioids and 

does not allow the medication to have full effect. The patient departed the PACU at 15:27 

per documentation. It is documented at 15:29, that oxygen was added to the patient’s 

treatment and she had to be reminded to breathe. It is below the standard of care to 

transfer a patient to the floor that must be reminded to breathe and had received opioids 

within 30 minutes of transfer time.  

 

Medication Onset Peak Duration Half-Life 

Dilaudid IV 10-15 min. 15-30 min. 2-3 hrs. 2.5-4 hrs. 

Fentanyl IV 1-2 min.  3-5 min.  30-60 min.  3.5 hrs.  

Versed IV  1-5 min.  5-7 min.  20-30 min.  1-5 hrs.  

 

Breaches in the Standard of care by Nurse Juliette Shepherd 

 

Nurse Shepherd failed to possess sufficient knowledge, training and experience in understanding 

the pharmacokinetics and pharmacodynamics of medications. She administered Valium 5mg 

orally at 16:09. According to Mosby’s 2019 Nursing Drug Reference, 32nd edition, Valium black 

box warning notes to avoid coadministration with 

Narrative Medical Report 
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